
Lesson 4:  Outlines, Hyperlinks, and HTML                                                                                                                                                                                                                       
Contents

	

	Instructional Resources
	Page

	
	Lesson Outline
	8

	
	Section 4.1: Working with the Outline Pane.
	9

	
	Section 4.2: Rearranging Outline Text.
	10

	
	Section 4.3: Moving Text and Slides in the Outline Pane.
	11

	
	Section 4.4: Importing and Exporting Outlines.
	12

	
	Section 4.5: Working with Hyperlinks.
	13

	
	Section 4.6: Saving a Presentation as a Web Page.
	14


File Listing

	Task
	Exercise
	Recommended Method
	Student Data File
	Solution File

	Use Zoom to Adjust the Size of Outline Text.

	4-1
	Click the Outline tab. Click the arrow next to Zoom box on the Standard toolbar and choose appropriate percentage from the list box. Alternatively, key the required percentage in the Zoom box.
	None

	None



	Add New Slides in the Outline Pane.

	4-2
	Click the New Slide button on the Formatting toolbar.

Choose the New Slide command from the Insert menu or pressing [Ctrl]+[M].

In the Outline pane, Place the insertion point at the end of a slide’s title text and press [Enter].
	None


	Sol 4-2.ppt

	Print a PowerPoint Outline.

	4-3
	Choose File, Print. Choose Outline View from the Print what drop-down list in the Print dialog box. Click Print.
	None


	None

	Promote and Demote Text to Change

Slide Level.

	4-4
	Click the Outline tab. To promote a bulleted item, click on it and then click the Promote button on the Outlining toolbar. Alternatively select the bulleted item, and drag it to the left. To demote a bulleted item, click on it and then click the Demote button on the Outlining toolbar. Alternatively select the bulleted item, and drag it to the right.
	None


	None

	Split and Join Slides.

	4-5
	To join two slides:

Click the Outline tab. Position the insertion point on the title placeholder. Click the Promote button on the Outlining toolbar.

To split two slides:

Click the Outline tab. Position the insertion point where the text has to be split. Click the Demote button on the Outlining toolbar until a new slide icon and number appears.
	None


	Sol 4-5.ppt

	Delete Slides and Slide Text.
	4-6
	Click the slide icon or bullet to select it and press [Delete].
	None


	None

	Move Bulleted Items.

	4-7
	To move up a bulleted item:
Click the bullet to select it and then click the Move Up button on the Outlining toolbar.
To move down a bulleted item:

Click the bullet to select it and then click the Move down button on the Outlining toolbar.
	None


	None

	Change How the Outline Pane Displays Text.

	4-8
	Click the Collapse All button to display the slide titles.
Click Expand button to display the details of the selected slides.

Click Collapse button to display only titles for selected slides.

Click Expand All button to display the details for entire outline.
	None


	None

	Rearrange Slides in the Outline Pane.
	4-9
	Click the slide to be moved. Click the Move Up or Move Down button on the Outlining toolbar as required. Alternatively, select the slide and drag to position it between the desired slides. 
	None


	Sol 4-9.ppt

	Export a presentation as a Rich Text Format

(RTF) Outline.
 
	4-10
	Choose File, Save As. Navigate to the desired folder in the Save As dialog box. Choose Outline/RTF from the Save as type drop-down list. Key the file name. Click Save. 
	None


	Sol 4-10.ppt

	Create an Outline in Word.
 
	4-11
	Open Microsoft Word. Choose File, New. Choose Blank Document in the new document task pane. Click the Outline View button. Key the required text. Use the Promote and Demote buttons Word’s Outlining toolbar to arrange the text. Save the outline.
	None


	Sol 4-11.ppt

	Create PowerPoint Slides from a Word

Outline.
	4-12
	Choose Insert, Slides from Outline. Choose the Word outline and click Insert in the Insert Outline dialog box.
	None


	Sol 4-12.ppt

	Insert a Hyperlink to Another Slide.

	4-13
	Select the text that has to set as hyperlink. Choose Insert, Hyperlink or press [Ctrl]+[K] to open the Insert Hyperlink dialog box. Click Place in This Document in the Link to box. Choose the slide to be linked in the Select a place box.
	None


	Sol 4-13.ppt

	Insert a Hyperlink to Another Presentation.

	4-14
	Select the text that has to set as hyperlink. Choose Insert, Hyperlink or press [Ctrl]+[K] to open the Insert Hyperlink dialog box. Click Existing File or Web Page in the Link to box. Choose the PowerPoint file to be linked in the Select a place box. Click the ScreenTip to open the Screen Tip dialog box. Key the text in the ScreenTip text box.
	CookCon2.ppt 
	Sol 4-14.ppt

	Insert a Hyperlink to an Excel Worksheet.

	4-15
	Select the text that has to set as hyperlink. Choose Insert, Hyperlink or press [Ctrl]+[K] to open the Insert Hyperlink dialog box. Click Existing File or Web Page in the Link to box. Choose the Excel file to be linked in the Select a place box.
	VendExp.xls 
	None

	Insert a Hyperlink to a Web Site.

	4-16
	Select the text that has to set as hyperlink. Choose Insert, Hyperlink or press [Ctrl]+[K] to open the Insert Hyperlink dialog box. Click Existing File or Web Page in the Link to box. Key the site address in the Address box. Click the ScreenTip to open the Screen Tip dialog box. Key the text in the ScreenTip text box.
	None


	Sol 4-16.ppt

	Use a Hyperlink During a Slide Show.

	4-17
	Point to the hyperlink text. (The pointer changes to a pointing hand shape.) Click the hyperlink.
	None


	

	Save in HTML File Format.
	4-18
	Choose File, Save as Web Page to open the Save As dialog box. Select Web Page from the Save as type list box. Using the Save In box, navigate to the desired folder. Click Save. 
	None


	Sol 4-18.ppt

	Work with the Outline pane, add slides, and demote outline entries.
	4-19
	
	None


	Sol 4-19.ppt

	Adjust the size of outline text using zoom, add slides, promote and demote bulleted items, and join slides.
	4-20
	
	AdMedia1.ppt


	Sol 4-20.ppt

	Promote and demote text, create an outline in Word and import it into PowerPoint; export a PowerPoint outline to Word.
	4-21
	
	None


	Sol 4-21.ppt

	Move bullets and slides in the Outline pane, create hyperlinks, and save the presentation as a Web page.
	4-22
	
	AdMedia2.ppt

Market3.ppt

Market4.ppt


	Sol 4-22.ppt

	Work with the Outline pane, add slides, promote and demote text, and move bullets and slides.
	4-23
	
	None


	Sol 4-23.ppt

	Promote outline items and move bullets in the Outline pane; save a presentation as a Web page.
	4-24
	
	Market3.ppt

	Sol 4-24.ppt

	Promote, demote, and move bulleted items in the Outline pane; move slides; and insert a hyperlink to a Word document.
	4-25
	
	HonProd1.ppt
Foods1.doc


	Sol 4-25.ppt

	Move bullets and slides, insert an outline from a word processing program into a presentation, and export an outline to Word.
	4-26
	
	Foods2.rtf
HoneProd2.ppt

HoneProd1.ppt


	Sol 4-26.ppt

	
	
	
	None
	None

	
	
	
	None
	None

	
	
	
	None
	None


The outline for this lesson will be presented in the following two sections:



Lecture Outline

· Highlights from the text

· Short discussions on difficult items

Lecture Notes

· Notes

· Teaching tips

· Text figures

· PowerPoint slides

Lesson Outline

Section 4.1

Working with the Outline Pane 

This section focuses on:

· Using Zoom to Adjust the Size of Outline Text
· Adding New Slides in the Outline Pane

· Printing a PowerPoint Outline

Section 4.2

Rearranging Outline Text

This section focuses on:

· Promoting and Demoting Text to Change Slide Level

· Splitting and Joining Slides

· Deleting Slides and Slide Text

Section 4.3

Moving Text and Slides in the Outline Pane 
This section focuses on:

· Moving Bulleted Items

· Changing How the Outline Pane Displays Text

· Rearranging Slides in the Outline Pane

Section 4.4

Importing and Exporting Outlines

This section focuses on:

· Exporting a Presentation as a Rich Text Format (RTF) Outline

· Creating an Outline in Word

· Creating PowerPoint Slides from a Word Outline

Section 4.5

Working with Hyperlinks

This section focuses on:
· Inserting a Hyperlink to Another Slide

· Inserting a Hyperlink to Another Presentation

· Inserting a Hyperlink to an Excel Worksheet

· Inserting a Hyperlink to a Web Site

· Using a Hyperlink During a Slide Show

Section 4.6

Saving a Presentation as a Web Page

This section focuses on:
· Saving in HTML File Format
	Lecture Outline
	Lecture Notes

	Section 4.1

Working with the Outline Pane 

The outline format helps users create, edit and rearrange slides in a presentation. Outlining focuses on content and flow rather than slide appearance.

The content for an outline can come from different sources. Users can import a Word outline to create a PowerPoint presentation automatically. They can also import data from other applications. A PowerPoint outline text can be exported to Word.
The Outline pane appears in Normal view. Users can display the pane by clicking the Outline tab on the upper-left side of the PowerPoint window. They can resize the Outline pane if required.

Using Zoom to Adjust the Size of Outline Text

The Zoom box is used to change the magnification of text in the Outline pane. It is also used to change the size of slide thumbnails, or change the magnification of a slide in the Slide pane. Zooming does not change the actual size of objects. When using Zoom, users need to click the pane that is to be magnified.

Adding New Slides in the Outline Pane


By default, any new slide inserted after the title slide, is formatted with the Title and Text layout. When working in the Slide pane, users can insert a new slide in one of the following methods:

· Clicking the New Slide button on the Formatting toolbar.

· Choosing the New Slide command from the Insert menu or pressing [Ctrl]+[M].

These methods can also be used when working in the Outline pane. In the Outline pane, a new slide can also be inserted by placing the insertion point at the end of a slide’s title text and pressing [Enter].

Printing a PowerPoint Outline

A PowerPoint outline can be printed using the Print dialog box or the Print Preview window. To print a PowerPoint, users need to:
· Choose File, Print.

· Choose Outline View from the Print what drop-down list in the Print dialog box.

· Click Print.
	Lesson Key Objective

Creating Outlines and inserting hyperlinks.


[image: image1.emf]Use Zoom to Adjust  the Size of Outline Text

 
[image: image2.emf]Add New Slides in  the Outline View


Text Figures: F04-01, F04-02
Text Figure: F04-03

Additional Notes:

When working in the Outline pane and using a two-column layout, use [CTRL]+[ENTER] to move to the second column. This key combination can be used in the Slide pane to move from one text placeholder to the next.

[image: image3.emf]Print a PowerPoint  Outline



	Section 4.2

Rearranging Outline Text

Users can perform many text-editing tasks in the Outline pane. They can promote or demote text to change slide level; join or split slides by demoting or promoting text; and delete slides or slide text. These editing tasks can be executed easily with of the help the Outlining toolbar, which provides tools to organize the text. Users can display this toolbar using the View menu.
Promoting and Demoting Text to Change Slide Level
Click the Outline tab. To promote a bulleted item, click the Promote button on the Outlining toolbar. To demote a bulleted item, click the Demote button on the Outlining toolbar.

Alternatively, users can promote or demote the text by selecting and dragging it to left or right when a four-pointed arrow appears. While dragging, a two-pointed horizontal arrow appears, indicating movement to left or right.

On dragging a selection up or down instead of left or right, the four-pointed arrow changes to a two-pointed vertical arrow, indicating changing the order of the lines or dragging the material to a different slide.

Splitting and Joining Slides

If there are too many bulleted items on one slide, users can divide the slide into two slides by promoting a selected item to becomes the title of the new slide.

Two slides can be joined by demoting the title of a slide. The demoted title and its body text are then added to the bottom of the previous slide

Deleting Slides and Slide Text

To delete a slide or a bulleted item, users need to click the slide icon or bullet to select it and press [Delete].


	
[image: image4.emf]Promote and Demote  Text to Change Slide Level


Teaching Tip:

Ensure students understand the difference between promoting/demoting and moving.

Teaching Tip:

Discuss the Outlining toolbar buttons listed in Table 4-1.
Additional Notes:

In Outline view, users can click anywhere in a text item or select the item before demoting or promoting with [Tab] or [Shift]+[Tab]. When working in the Slide pane, users must ensure that the insertion point is at the beginning of the text item. If the insertion point is placed inside the text, pressing [Tab] or [Shift]+[Tab] inserts a tab space within the text.
Text Figure: F04-04


[image: image5.emf]Split and Join Slides


Text Figure: F04-05



	Section 4.3

Moving Text and Slides in the Outline Pane 

In the Outline pane, users can move the selected bulleted items or entire slides in

different ways:

· Using the Move Up button or the Move Down button on the Outlining toolbar.

· Dragging selected bullets up or down.

· Using the Cut and Paste command.
If the Move Up button or the Move Down button is clicked without first selecting an item, only the item that contains the insertion point is moved. To move entire slides to a new position, users need to first click the Collapse All button to collapse the outline and move the slides. When the outline is collapsed, only the slide icons and the slide titles are displayed. This makes it easier to move an entire slide without accidentally dropping the slide in the middle of another slide.

Moving Bulleted Items

To move a bulleted item, users need to click the item and then click the Move Up or Move Down button on the Outlining toolbar. 
Changing How the Outline Pane Displays Text

By default, the Outline pane displays text in an unformatted style. It can be changed to display the text formatting that is used on the actual slides. The extent of text displayed by collapsing or expanding the outline can also be controlled.
Rearranging Slides in the Outline Pane

Drag a slide to rearrange it between the desired slides. When a collapsed slide is selected (or moved), all its hidden text is selected (or moved).

	
[image: image6.emf]Move Bulleted Items

 
[image: image7.emf]Change How the  Outline Pane Displays Text


Teaching Tip:

Have students practice dragging a bullet or a slide icon to a different position in the outline. 

Text Figure: F04-06

Text Figures: F04-07, F04-08



	Section 4.4

Importing and Exporting Outlines

Importing means using a file created in a different application. Exporting means saving a file in a format that can be read by a different application.

Users can import an outline created in another application (such as Microsoft Word) into a new presentation or an existing one. PowerPoint uses the outline's structural formatting (tab characters, indents, or heading styles) to create slide titles and bulleted items.

PowerPoint presentation can also be exported to other applications by saving them in the standardized rich text format (.rtf). The rich text format preserves text formatting in a way that can be read by other Microsoft Office programs as well as numerous other programs that are not part of the Microsoft Office suite. However, this format does not save the graphic elements in a presentation.
Exporting a Presentation as a Rich Text Format (RTF) Outline

To export a presentation as a rich text format outline, users need to:

· Choose File, Save As. 
· Navigate to the desired folder in the Save As dialog box.
· Choose Outline/RTF from the Save as type drop-down list.
· Key the file name and click Save.
Creating an Outline in Word

To create an outline in Word, users can key the text in Word’s Outline view using the Promote and Demote buttons on Word’s Outlining toolbar. 

An alternative way to create the Word outline is to assign heading styles to the outline levels. Use the style Heading 1 for the title, Heading 2 for the first level of bulleted text, and so on.

Creating PowerPoint Slides from a Word Outline

To create PowerPoint slides from a Word outline, users need to:

· Choose Insert, Slides from Outline.

· Choose the Word outline and click Insert in the Insert Outline dialog box.

	
[image: image8.emf]Export a  Presentation as a RTF Outline

 
[image: image9.emf]Create an Outline in  Word


Text Figure: F04-09
Additional Notes:

Users can save a presentation as an outline in Word format by choosing File, Send To, Microsoft Office Word.
Text Figure: F04-10


[image: image10.emf]Create PowerPoint  Slides From a Word Outline




	Section 4.5

Working with Hyperlinks

Hyperlinks provide another way to get outside information into a presentation. Users can link to slides in the same presentation, slides from other presentations, files from other applications and Web pages. Users can create hyperlinks using text, Action buttons, or objects.

Users can insert hyperlinks using the Insert, Hyperlink command, using the Hyperlink button on the Standard toolbar or pressing [Ctrl]+[K].

Inserting a Hyperlink to Another Slide

To insert a hyperlink to another slide within a presentation:
· Select the text that has to set as hyperlink.

· Choose Insert, Hyperlink or press [Ctrl]+[K] to open the Insert Hyperlink dialog box.

· Click Place in This Document in the Link to box.

· Choose the slide to be linked in the Select a place box.

Inserting a Hyperlink to Another Presentation

When creating a hyperlink to another file (for example, to another PowerPoint presentation), it is recommended that users first copy or save the file to the same directory as the presentation containing the hyperlink. If the presentation is moved to another location, the hyperlinked file should be moved as well, otherwise, the hyperlink would no longer work. 

Inserting a Hyperlink to an Excel Worksheet
To insert a hyperlink to an Excel Worksheet:

· Select the text that has to set as hyperlink.

· Choose Insert, Hyperlink or press [Ctrl]+[K] to open the Insert Hyperlink dialog box.

· Click Existing File or Web Page in the Link to box.

· Choose the Excel file to be linked in the Select a place box.

Inserting a Hyperlink to a Web Site

To insert a hyperlink to a Web site:

· Select the text that has to set as hyperlink.

· Choose Insert, Hyperlink or press [Ctrl]+[K] to open the Insert Hyperlink dialog box.

· Click Existing File or Web Page in the Link to box.

· Key the site address in the Address box.

· Click the ScreenTip to open the Screen Tip dialog box.
· Key the text in the ScreenTip text box.
Using a Hyperlink During a Slide Show

In PowerPoint, hyperlinks become active only when users run the presentation. When users point to a hyperlink, the pointer becomes a hand, indicating that it can be clicked.
	Text Figure: F04-11

Text Figure: F04-12


[image: image11.emf]Insert a Hyperlink to  Another Presentation

 
Text Figures: F04-13, F04-14

[image: image12.emf]Insert a Hyperlink to  an Excel Worksheet


Teaching Tip:

Inform students that Web addresses often change and hence the Web address provided in a hyperlink might not exist certain times.
Text Figure: F04-15


	Section 4.6

Saving a Presentation as a Web Page

When a presentation file is saved in the HTML (Hypertext Markup Language) file format, it can be opened and viewed in a browser. It can also be published over the Internet. A PowerPoint presentation file saved in HTML format can be read using Microsoft Internet Explorer 4.0 or a later version.
Saving in HTML File Format

To save a PowerPoint file in HTML format:

· Choose File, Save as Web Page to open the Save As dialog box.
· Select Web Page from the Save as type list box.
· Navigate to the desired folder using the Save In box.
· Click Save.
	
[image: image13.emf]Save a Presentation  as a Web Page


Additional Notes:

PowerPoint creates a folder of supporting files when a presentation is saved in HTML format. This folder is saved in the same location as the HTML file, as it is necessary to display the HTML file in a browser. If users move the HTML file to another location, they need to make sure that the supporting file folder is also moved along with it.
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